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IMPORTANT INFORMATION 

Please read the following information before use. In case of any questions, please contact miniDSP via the 

support portal at support.minidsp.com. 

System Requirements 

To configure your DDRC-88A audio processor, you will require a Windows or Apple Mac computer with the 

following minimum specification: 

Windows 

• Microsoft• ® Windows® 10 or 11, latest version with all updates 

• At least a dual core i3, i5, or i7 processor 

• At least 2 GB RAM (4 GB preferred) 

• Two free USB 2.0 ports 

• Internet connection 

macOS 

• macOS 10.14 Mojave or later, latest version with all updates 

• At least a dual core i3, i5, or i7 processor, or an ARM processor (M1/Pro/Max) 

• At least 2 GB RAM (4 GB preferred) 

• Two free USB 2.0 ports 

• Internet connection 

Disclaimer/Warning 

miniDSP cannot be held responsible for any damage that may result from the improper use or incorrect 

configuration of this product. Please read this manual carefully to ensure that you fully understand how to 

operate and use this product, as incorrect use or use beyond the parameters and ways recommended in this 

manual have the potential to cause damage to your audio system. 

Please also note that many of the questions we receive at the technical support department are already 

answered in this User Manual and in the online application notes on the miniDSP.com website. So please take 

the time to carefully read this user manual and the online technical documentation. And if an issue arises with 

your unit, please read through the Troubleshooting section first. Thank you for your understanding! 

Warranty Terms 

miniDSP Ltd warrants this product to be free from defects in materials and workmanship for a period of one 

year from the invoice date. Our warranty does not cover failure of the product due to incorrect connection or 

installation, improper or undocumented use, unauthorized servicing, modification or alteration of the unit in any 

way, or any usage outside of that recommended in this manual. If in doubt, contact miniDSP prior to use. 

FCC Class B Statement 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

• This device may not cause harmful interference. 

http://www.minidsp.com/
https://support.minidsp.com/
http://www.minidsp.com/applications
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• This device must accept any interference received, including interference that may cause undesired 

operation. 

Warning: This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection. This 

equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance 

with the instructions, may cause interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful interference to radio 

or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 

try to correct the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

Notice: Shielded interface cable must be used in order to comply with emission limits. 

Notice: Changes or modification not expressly approved by the party responsible for compliance could void the 

user’s authority to operate the equipment. 

CE Mark Statement 

The DDRC-88A has passed the test performed according to European Standard EN 55022 Class B. 

A Note on this Manual 

This User Manual is designed for reading in both print and on the computer. If printing the manual, please print 

double-sided. The embedded page size is 8 ½” x 11”. Printing on A4 paper will result in a slightly reduced size. 

For reading on the computer, we have included hyperlinked cross-references throughout the manual. In 

addition, a table of contents is embedded in the PDF file. Displaying this table of contents will make navigation 

much easier: 

• In Adobe Reader on Windows, click 

on the “bookmarks” icon at the left. 

The table of contents will appear on 

the left and can be unfolded at each 

level by clicking on the “+” icons. 

• In Preview on the Mac, click on the 

View menu and select Table of 

Contents. The table of contents will 

appear on the left and can be 

unfolded at each level by clicking on 

the triangle icons. 

 

 

  

http://www.minidsp.com/
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1 PRODUCT OVERVIEW 

Thank you for purchasing a miniDSP DDRC-88A audio processor powered by Dirac Live®, the world’s premier 

room correction solution. We are delighted to offer you this software and hardware combination, the fruit of 

extensive research and development and years of experience in sound system tuning. 

The DDRC-88A is an 8-channel digital audio signal processor (DSP) running the Dirac Live® room correction 

algorithm. The onboard floating-point SHARC processor provides time and frequency correction of a 7.1 

monitoring, home theater or multichannel audio system. Inputs and outputs are analog, available as both single-

ended signals connected via RCA jacks, and as balanced signals via Phoenix terminal blocks. 

The DDRC-88A is a member of the miniDSP Dirac Series of audio processors. Deploying a DDRC-88A will: 

• Improve imaging and immersion 

• Improve clarity of music and dialog 

• Produce a tighter bass 

• Reduce listening fatigue 

• Remove resonances and room modes 

The DDRC-88A can be used anywhere an 8-channel room correction processor is required, such as in home 

theaters, recording and mastering studios, performance venues, places of worship, and so on. An optional 

enhanced/bass management software upgrade provides additional advanced functionality such as bass 

management, active crossovers, and multi-sub configuration. 

1.1 TYPICAL SYSTEM CONFIGURATIONS 

The DDRC-88A is inserted between line-level analog sources and power amplification. In a typical home theater 

application, line-level signal to the DDRC-88A is produced by an A/V receiver or processor with one or more 

source devices connected, and the amplification is typically a multichannel power amplifier. A source such as a 

Blu-ray player with multichannel analog outputs can instead be connected directly to the DDRC‑88A.  

http://www.minidsp.com/
http://www.minidsp.com/products/dirac-series
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In studio or sound reinforcement applications, the DDRC-88A is typically connected between a mixing console 

and power amplification, as shown below. Individual channels can be set for either full-range or subwoofer 

operation. 

 

In its enhanced mode of operation, the DDRC-88A is capable of a number of other signal processing functions, 

such as bass management and active crossovers. The diagram below illustrates an application in which the 

DDRC-88A implements active crossovers for the left, right and center speakers, as well as managing two 

subwoofers. Where necessary, additional units can be used to attain the necessary number of output channels. 

 

The DDRC-88A can also be used for multi-room/multi-zone correction with a stereo source. See the application 

note on our website, Multi-zone DRC with the DDRC-88A Dirac Live® processor. 

Computer connectivity is used to perform acoustic measurements and generate digital room correction filters. 

Up to four sets of correction filters can be stored on the DDRC-88A processor and recalled from the front panel 

or via an infrared remote. Once the processor is fully configured, the computer is no longer needed. 

http://www.minidsp.com/
https://www.minidsp.com/applications/home-theater-tuning/ddrc-88a-in-a-multizone-setup
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1.2 DIRAC LIVE 

The DDRC-88A processor executes Dirac Live® digital room correction, from Dirac Research. Dirac Live’s mixed-

phase filtering technology will improve the imaging of your system, minimize the effects of room modes and 

resonances, and improve dynamics and clarity. 

To accomplish its remarkable improvement in listening quality, the DiracLive application steps you through the 

procedure for taking measurements around your listening area. Dirac Live® employs a sophisticated analysis 

algorithm to make the optimal correction across the whole listening area, not just at a single point. The user has 

full control over the target frequency response. Measurements are taken with a calibrated acoustic 

measurement microphone, the miniDSP UMIK-1.1 

 

In addition to correcting magnitude response, Dirac Live® corrects the system’s impulse response, which reflects 

how the system responds to a sharp transient such as a drumbeat. Reflections, diffraction, resonances, 

misaligned drivers, and so on, all combine to smear out the transient. Correcting the impulse response makes 

the speaker in the room behave much more like an ideal loudspeaker. The impulse response is a critical factor 

for accurate sound-staging, clarity and bass reproduction. 

 

Dirac Live calibration is described in the separate miniDSP Dirac Live User Manual. 

 
1 A UMIK-1 is included in the standard purchase price of the DDRC-88A processor. 

http://www.minidsp.com/
https://www.dirac.com/
https://www.minidsp.com/images/documents/miniDSP%20Dirac%20Live%20User%20Manual.pdf
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2 HARDWARE CONNECTIVITY 

All connections to the DDRC-88A are made on the rear panel. 

2.1 ANALOG INPUT AND OUTPUT 

Up to eight channels can be connected to the DDRC-88A. Be sure to take careful note of the channel numbering: 

 

 

On the input side, it is very strongly recommended that all connections be of the same type – i.e. balanced or 

unbalanced. The Dirac Live algorithm equalizes levels on all channels, and a mixture of balanced and unbalanced 

connections on the input side will require special gain adjustment steps after Dirac Live calibration. 

On the output side, a mixture of balanced and unbalanced connections can be used if desired. Doing so may 

necessitate additional work to check and adjust system gain structure. For more information on gain structure, 

see Gain structure starting on page 24. 

Unbalanced connections are made directly 

to the RCA jacks. 

 

 

 

Balanced connections are made by 

connecting bare wire ends to the push-in 

Phoenix terminal blocks. For advice on 

using these, see Balanced wiring tips on 

page 45. 

http://www.minidsp.com/
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2.2 DC POWER 

Fit the supplied IEC cable to the 12 VDC power supply. Plug the AC mains plug into the power outlet, and then 

plus the DC connector into the +12VDC socket on the rear panel of the DDRC-88A. 

 

Apply power to the DDRC-88A only after all analog input and output connections have been made. The 

DDRC-88A uses little power and can be left powered on. 

If powered on and off, the following turn-on/turn-off sequence is recommended: 

• On: Power on line-level equipment, including the DDRC-88A, then turn on power amplification. 

• Off: Turn power amplification off, then power off line-level equipment, including the DDRC-88A. 

2.3 USB 

To configure the DDRC-88A using the DiracLive application: 

• Connect the USB port of the DDRC-88A to a USB 2.0 port on your computer using the supplied cable. 

• Connect a miniDSP UMIK-1 to a second USB port on your computer. 

Note: the miniDSP UMIK-1 is the recommended and supported measurement microphone for use with the 

DDRC-88D and the DiracLive application. miniDSP cannot provide support for use of other microphones. 

http://www.minidsp.com/
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3 SOFTWARE INSTALLATION 

The DDRC-88A is configured with software running on a PC or Mac. There are two sets of software to download 

and install, from dirac.com and from miniDSP.com. 

3.1 WINDOWS 

This section describes software download and installation for Windows 10 and 11. 

 

The software described in this section runs on the latest version of Windows 10 or Windows 11 only. 

Other versions of Windows are not supported by the current version of Dirac Live. 
 

3.1.1 Download and install the DiracLive application 

Download the DiracLive application for Windows from https://www.dirac.com/live/downloads/. 

Double-click on the downloaded installer to run it. Be sure to accept the default installation settings. Do not run 

the application yet. 
 

3.1.2 Download the miniDSP software 

If you purchased your processor directly from miniDSP, your software will be available from the User Downloads 

section of the miniDSP website when your order ships. To access the download, you will need to be logged into 

the website with the account you created when purchasing. 

If you purchased your processor from a miniDSP dealer, you will receive a coupon together with the product. 

Redeem this coupon at the link below: 

• https://www.minidsp.com/support/redeem-coupon 

The User Downloads link is visible from the dropdown menu at the top right of the website: 

 

Navigate to the Dirac Series section then to the DDRC-88A / DDRC-88D Software section. Download the zip file 

under the heading DDRC-88A – Dirac 3.x build. 

After downloading, unzip the file (right-click and select “Extract All...”). The unzipped download has a name like 

DDRC-88-BM_v2_5_FW_v2.26. (The version numbers embedded in the folder name may be different.) 

http://www.minidsp.com/
https://www.dirac.com/live/downloads/
https://www.minidsp.com/userdownloads
https://www.dirac.com/live/downloads/
http://www.minidsp.com/userdownloads
https://www.minidsp.com/support/redeem-coupon
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3.1.3 Install the miniDSP software 

3.1.3.1 Possible Windows installation issues 

The miniDSP software requires that a number of other frameworks be installed for it to work. These packages 

should be installed automatically, but you can manually install them if you receive an error message that 

required software is missing. 

• Microsoft .NET framework (version 3.5 or later) 

• Microsoft Visual C++ 2010 Redistributable Package: for x86 (32-bit Windows) or x64 (64-bit Windows). 

3.1.3.2 Install the plugin 

1. Navigate to the Plugins folder of the software download and then to the Windows folder. 

2. Double-click on the plugin installer to run it. It will be named DDRC_88_BM.exe. We recommend that you 

accept the default installation settings. 

 

Note: the first time you run the DDRC-88BM plugin and the DiracLive application, you may see a Windows 

Firewall warning such as the one below. Ensure that “Private networks...” is checked and “Public networks...” is 

not checked. Then click on “Allow access.” This warning dialog may appear more than once. 

http://www.minidsp.com/
http://www.microsoft.com/en-us/download/details.aspx?id=17851
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=5555
http://www.microsoft.com/en-us/download/details.aspx?id=14632
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3.2 MACOS 

This section describes software download and installation for macOS. 

 

The software described in this section runs on macOS 10.14 Mojave or later only. Earlier versions of 

macOS / OS X are not supported by the current version of Dirac Live. 
 

3.2.1 Download and install the DiracLive application 

Download the DiracLive application for macOS from https://www.dirac.com/live/downloads/. 

Double-click on the downloaded file to unzip it. Then double-click on the unzipped installer file to run it. Be sure 

to accept the default installation settings. Do not run the application yet. 

3.2.2 Download the miniDSP software 

If you purchased your processor directly from miniDSP, your software will be available from the User Downloads 

section of the miniDSP website when your order ships. To access the download, you will need to be logged into 

the website with the account you created when purchasing. 

If you purchased your processor from a miniDSP dealer, you will receive a coupon together with the product. 

Redeem this coupon at the link below: 

• https://www.minidsp.com/support/redeem-coupon 

The User Downloads link is visible from the dropdown menu at the top right of the website: 

 

Navigate to the Dirac Series section then to the DDRC-88A / DDRC-88D Software section. Download the zip file 

under the heading DDRC-88A – Dirac 3.x Build. 

After downloading, unzip the file (right-click and select “Extract All...”). The unzipped download has a name like 

DDRC-88-BM_v2_5_FW_v2.26. (The version numbers embedded in the folder name may be different.) 

 

http://www.minidsp.com/
https://www.dirac.com/live/downloads/
http://www.minidsp.com/userdownloads
https://www.minidsp.com/support/redeem-coupon
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3.2.3 Install the miniDSP software 

3.2.3.1 Possible Mac installation issues 

If double-clicking on the installer brings up a message that the installer cannot run, use this alternate method 

(note that the name of the installer will be the actual name, not MiniDSP_Plugin.pkg as shown in the 

screenshots):  

1. Right-click on the installer (or click while holding the Control key). 

2. Move the mouse over the “Open With” item and then click on “Installer (default).” 
 

3. The following window will appear. Click on “Open.” 

 

3.2.3.2 Install the plugin 

1. Navigate to the Plugins folder of the software download and then to the Mac folder.  

2. The installer is named DDRC-88-BM_v2_5.pkg. (The version number in the filename may be different.) To 

run it, double-click on it, or right-click and open as described above. We recommend that you accept the 

default installation settings. 

3. To run the plugin, locate it in the Applications -> miniDSP folder and double-click on it. To make it easier to 

run in future, right-click on its dock icon and select Options -> Keep in Dock. 

3.2.3.3 Enable file sharing for device discovery 

To enable device discovery, open System Preferences, go to Sharing, then 

enable File Sharing as shown at right. 

Notes: 

a) This step is not always necessary and may depend on your Mac’s 

configuration or your home network setup. 

b) If you wish, you can turn File Sharing off again after completing your 

Dirac Live calibration. 

http://www.minidsp.com/
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4 THE DDRC-88BM PLUGIN 

The DDRC-88BM plugin is the software program that interfaces with the DDRC-88A for all control functions 

except for Dirac Live calibration. It can operate in two modes: 

• Basic mode. Dirac Live is enabled but the optional bass management and crossover functionality is not. 

• Enhanced/bass management mode. Dirac Live is enabled as well as bass management and crossover 

functionality. See Section 8, Enhanced/Bass Management Mode for further information on this functionality. 

If you purchase a DDRC-88A in basic mode and later upgrade to enhanced/bass management mode, you will 

need to perform the upgrade procedure described on page 51. 

 Be sure to quit the DiracLive application before pressing the Connect button in the DDRC-88BM 

plugin. This avoids any possible communication conflicts. 

4.1 PLUGIN USER INTERFACE – BASIC MODE 

Upon starting the plugin, the main user interface appears. The screenshot below shows the user interface with 

the key areas highlighted. 
 

At the top of the screen are a set of menus and buttons, which are described on following pages. Below that, on 

the Dirac tab, is a display of the Dirac Live parameters. This tab is active in both basic and enhanced/bass 

management modes. 

The four other tabs (“LFE Mgt,” “Routing,” etc) are not active in basic mode. They can be viewed when the 

plugin is offline (see next page) in order to provide you with a preview of the enhanced/bass management 

functionality. 

http://www.minidsp.com/
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4.2 MASTER CONTROL 

The DDRC-88BM plugin can communicate with the processor using either USB or over the network. For USB 

communication, connect the DDRC-88A to a USB 2.0 port on your computer. Then click on the Connect button: 

If you are running the plugin in enhanced/bass management mode, a dialog box with additional connection 

options may appear. See page 33. 

For networked communication with the processor, a miniDSP WI-DG Wifi/Ethernet to USB bridge must be used 

together with the IP Address and Auto fields. See the Wi-DG User Manual for details. 

If connection is successful, the Connect button will change to a green tick as shown above. For the sake of 

brevity, this state is referred to as “online” whereas the earlier state with the circular arrows is referred to as 

“offline.” In addition, the Master Volume field will display the current volume setting:  

 

When the plugin is online, the Mute button disables all audio output: 

 

The Dirac Live button turns Dirac Live filtering on and off. (A Dirac Live correction filter must have been loaded 

into the currently selected configuration for this to work.) 

4.3 CONFIGURATION/FILTER SET SELECTION 

Once correction filters have been loaded into the DDRC-88A, the four configuration selection buttons can be 

used to select between them. 

If the plugin is operating in enhanced/bass management mode, these buttons also select the processing data for 

the four other tabs (“LFE Mgt,” “Routing,” etc). Because these different configurations contain data that has 

been already loaded into the flash memory of the hardware unit, they are also often referred to as “presets.” 

Configuration/preset selection can also be done with the front panel encoder or an infrared remote control – 

see Section 6, Using the DDRC-88A Audio Processor. 

By default, configuration 1 is selected: 

 

 

http://www.minidsp.com/
https://www.minidsp.com/products/accessories/wi-dg
https://www.minidsp.com/images/documents/Wi-DG%20User%20Manual.pdf
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4.4 DIRAC LIVE INFORMATION 

In basic mode, the only active tab in the interface is Dirac. Dirac Live calibration is performed with the separate 

DiracLive application, as described in the miniDSP Dirac Live User Manual. Once calibration has been performed, 

you can quit DiracLive and run the plugin to view Dirac Live delay and gain settings and real-time levels. 

This tab displays the gains and delays of the Dirac Live filters loaded into the DDRC-88A. (The plugin must be 

online to display them.) These gains and delays were calculated by DiracLive during its Optimize phase and 

cannot be changed by the user – they are “read only.” Here is an example: 

 

Note that the displayed gains and delays are applied even when Dirac Live filtering is turned off. (In order to pass 

audio through without gain and levels adjustment, you will need to leave an empty slot on the Export tab of the 

DiracLive application.) 

The Input and Output columns display the current signal level at the inputs and outputs of the Dirac Live 

processing block. 

The button is used to turn Dirac Live processing on and off. 

 

4.5 START DIRAC LIVE SOFTWARE 

The Start Dirac Live Software button starts the separate DiracLive application. When it is pressed, the DDRC-

88BM plugin will disconnect from the DDRC-88A processor and then start up DiracLive. 

 

You must start the DiracLive application from within the DDRC-88BM plugin using the Start Dirac 

Live Software button. If you open the DiracLive application by itself, it will not be able to detect the 

DDRC-88A processor. 

http://www.minidsp.com/
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5 DIRAC LIVE CALIBRATION 

Dirac Live calibration with the miniDSP DDRC-88A is described in the separate miniDSP Dirac Live User Manual. It 

can be downloaded from the DDRC-88A product page on our website. 

 

Be sure to start the DiracLive application from within the DDRC-88BM plugin using the Start Dirac 

Live Software button. If you open the DiracLive application by itself, it will not be able to detect the 

DDRC-88A processor. 

 

http://www.minidsp.com/
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6 USING THE DDRC-88A AUDIO PROCESSOR 

Once the desired correction filters have been downloaded into the DDRC-88A audio processor, the computer is 

not required and can be disconnected. 

6.1 CONFIGURING SOURCE EQUIPMENT 

Because of the effect of the Dirac Live algorithm, the settings required in source equipment may differ to the 

settings used prior to deploying the DDRC-88A. 

6.1.1 Level trims 

Dirac Live aligns the gain of all channels. The level trims of all channels in the source equipment should therefore 

all be set to the same value (typically 0 dB). 

6.1.2 Bass management 

If you are using bass management, follow the instructions of the equipment manufacturer to reconfigure bass 

management after performing your Dirac Live calibration. The bass management settings that you had prior to 

including the DDRC-88A in your system may no longer be valid due to the changes in system response 

introduced by Dirac Live. 

6.1.3 Delays/speaker distance 

Dirac Live calculates the relative delays between all channels and corrects for any differences. In the source 

equipment, all delays (or equivalently, speaker distance) should therefore be set to the same value, so that the 

delays calculated by Dirac Live are effective. 

6.1.4 Room correction and EQ 

Turn off any room correction in the source equipment. Dirac Live performs a full set of sophisticated room 

correction optimization algorithms, and “adding” additional room correction in the source equipment will not 

improve the result, and quite possibly make it worse. 

EQ that is being used for room correction should also be turned off. If EQ is being used for subjective tuning, 

note that target curves (see Designing your target curve) can be used to create different filter sets for different 

subjective effect. We therefore recommend that target curves be used to tailor the sound on all channels to 

your liking first, and only then apply EQ in the source equipment if there is a need for rapid “on the fly” 

subjective EQ adjustments. 

6.1.5 Other processing 

Any other processing can be applied in the same manner as you did prior to deploying the DDRC-88A in your 

system. In a home theater context, this includes down-mixing (for example from 7.1 to 5.1), up-mixing (including 

decoders such as Dolby Pro Logic), and “effects” such as hall or ambience simulators. In a studio or sound 

reinforcement context, effects such as reverberation can continue to be used as before. Compressor/limiters 

used to protect power amplifiers should, however, remain connected between the DDRC-88A and the power 

amps. 

http://www.minidsp.com/
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6.2 FRONT PANEL 

The front panel and/or an infrared remote can be used to control: 

• Filter set selection 

• Master volume 

• Master mute (remote control only) 

• Dirac Live® filtering enable/bypass (remote control only) 

 

6.2.1 Status indicators 

The current status of the DDRC-88A is indicated by a set of LEDs: 

Dirac Live Dirac Live® filtering is enabled. This LED also blinks when the unit is muted. 

Filter Set Indicates the currently selected filter set (1 through 4). 

6.2.2 Front panel controls 

The DDRC-88A audio processor uses a minimalist physical control design with a single control knob. 

To change the volume 

 Rotate the control knob clockwise to increase the volume, and counter-clockwise to decrease it. 

To change the selected filter set 

 Briefly press the control knob. The current Filter Set LED blinks quickly. Rotate the control knob 

until the desired Filter Set LED is blinking. Press the control knob again, and the selected LED will 

remain steady. 

http://www.minidsp.com/
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6.3 INFRARED REMOTE CONTROL 

Once configuration is complete, the computer is not required and can be disconnected. An infrared remote can 

be used to control volume, mute, preset selection, and to turn Dirac Live processing on and. 

6.3.1 miniDSP remote 

By default, the DDRC-88A recognizes commands from the optional miniDSP remote:  

Source 

 Has no effect with the DDRC-88A. 

1, 2, 3, 4 

 Switches to the selected preset. Note that it takes a few seconds for the 

preset selection to complete, while the processor loads the new filters 

from its flash memory into the DSP. 

[Bell] 

 Enables or disables Dirac Live filtering. Dirac Live filtering will be effective 

only on presets for which Dirac Live filters have been loaded. 

Vol 

 Reduce or increase the volume. 

Mute 

 Mutes and unmutes audio output.  

 

 

6.3.2 Apple remote 

The DDRC-88A also recognizes the Apple Remote, with the 

key assignments shown at right. 

The commands Config Inc and Config Dec change the 

selected configuration preset up or down. For example, if the 

currently selected preset is 1, pressing Config Inc changes it 

to 2. Note that it takes a few seconds for the preset selection 

to complete, while the processor loads the new filters from 

its flash memory into the DSP. 
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6.3.3 Programming a third-party remote 

Alternatively, the DDRC-88A can “learn” the control codes of your current remote if it supports one of the 

following remote control codes: 

• NEC 

• Sony 

• Philips RC6 

To initiate the learning process, run the DDRC-88BM plugin and click Connect. Drop down the IR Remote menu 

and select IR learning. Click on the Learn button for an operation, and then press the desired button on the 

remote control. If the code is accepted, a dialog will appear to show that the code was recognized. Cick OK, then 

a green tick will appear next to the command. 

 

If the processor does not recognize the remote control code, then it will time out and display a message saying 

that IR learning failed. 

Once programmed, check that the programmed buttons perform the expected function. Note that miniDSP 

remote and Apple remote commands will not be recognized once a different remote code has been learned. 

 

 

To "unlearn" a command, press the Learn button and wait for the plugin to time out. Note that 

you cannot “learn” the miniDSP remote – if you program another remote and want to revert to 

using the miniDSP remote, simply “unlearn” all codes. (Applies to firmware v2.23 and later.) 
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7 GAIN STRUCTURE 

When deploying a DSP solution in your audio system, a topic that becomes more important than with analog 

equipment is gain structure. This means that the signal levels throughout the system should be set high enough 

to maximize digital resolution and minimize noise, but not so high as to result in clipping and distortion. 

The DDRC-88A provides a great deal of flexibility in matching with other equipment. In addition to providing 

balanced and unbalanced inputs and outputs, input sensitivity and output gain can be selected to adapt to 

different equipment. The DDRC-88A ships with a conservative gain structure that will rarely result in clipping, 

but you may wish to adjust these settings for your own installation. This section explains gain structure and how 

to optimize it. 

7.1 GAIN STRUCTURE OVERVIEW 

Figure 6.1 below illustrates the elements that affect gain and gain structure (for a single channel). The 

source/processor has a master volume control and typically a user-settable trim control on each output channel. 

It may also have an additional 10 dB gain on the LFE channel. The DDRC-88A has a master volume control and an 

internal trim control (not visible to the user). In addition, there are per-channel settings for input sensitivity and 

output gain. Finally, the power amplifier itself may have a master gain control or a level trim on each channel. 

Figure 6.1. Overview of gain structure through the system 

http://www.minidsp.com/
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7.2 CHOOSING GAIN STRUCTURE SETTINGS 

The input sensitivity is the voltage that generates a full-scale digital input signal to the DDRC-88A’s DSP (digital 

signal processor). The output gain setting specifies the voltage that results from a full-scale digital output signal 

from the DSP. 

The best choice of input sensitivity and output gain settings can be determined in two ways: by the output level 

of the source and the input sensitivity of the amplifier, or by the resulting input-output gain of the DDRC-88A. 

We suggest initially using Figure 6.2 as follows: 

1. Knowing the maximum output level of your source equipment, run a line across to either Unbalanced input 

or Balanced input. The best input sensitivity is the one that your line intersects. If you are in the red zone, 

limit the master volume control on your source equipment to avoid overloading the DDRC-88A input. 

2. Compare the maximum output level of your source equipment with the input sensitivity of your 

amplification, and choose the lowest number. Then run a line across to either Unbalanced output or 

Balanced output. The best output gain setting is the one that your line intersects. (With this 

recommendation we allow the possibility that the DDRC-88A may overdrive the amplifier. Since Dirac Live 

will tend to reduce output levels somewhat, over-driving it is unlikely in practice.) 

If your equipment offers a choice of unbalanced or balanced inputs or outputs, this diagram can also be used to 

help choose which type of connection to use. Note that there is no sensitivity adjustment for balanced inputs 

(the only available choice is 8 VRMS). In addition, if an input channel is set for 0.9V sensitivity, a balanced 

connection can not be made to that channel.  

 

All input channels must have the same type of connection (balanced or unbalanced) and the same 

input sensitivity setting. (Output channels can have a mix of balanced and unbalanced connections 

and a mix of output gain settings. If using a mix, always do a Gain structure optimization.) 

 

Changing connection type or gain structure settings of individual channels will invalidate all of your 

existing Dirac Live projects. Therefore, if making a change to gain structure, you must either change 

all channels in the exact same way, or completely redo your Dirac Live calibration afterwards. 

 

If, after performing an initial calibration with the DiracLive application, you find that the input-output gain is not 

suitable for your system, then refer to Figure 6.3 to choose different settings that match your desired input-

output gain. 
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Figure 6.2. Gain structure settings based on input and output levels 

 

 

  Unbalanced output  Balanced output 

 Setting 0.9V 2V  4V 8V 

Unbalanced input 
0.9V 0 dB 6 dB  12 dB 18 dB 

2V −6 dB 0 dB  6 dB 12 dB 

       

Balanced input 8V −18 dB −12 dB  −6 dB 0 dB 

Gain values are simplified to give exact multiples of 6dB. 

Figure 6.3. Input-output gain determined by connection type and gain structure settings 
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7.2.1 To change input sensitivity 

Input sensitivity can be changed for unbalanced connection only, by moving a set of three jumpers on each 

channel. The diagram below illustrates the location of the jumper headers for each channel. For each channel 

that is to be changed, lift the jumpers and replace them in either the OPEN position (jumper pushed onto one 

pin only) or CLOSED position (jumper pushed onto both pins). 

 

Do not make a balanced connection to the input of any channel with jumpers in the CLOSED position. 

 

7.2.2 To change output gain 

A set of eight DIP switches located on the main circuit board select the output gain of each channel. The 

switches can be set independently for each channel, and affect output gain for both the balanced and 

unbalanced output connections to that channel. 
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7.3 OPTIMIZING GAIN STRUCTURE 

If the acoustic output level of different channels shows substantial differences (greater than 6 dB), then there 

may be room to improve the gain structure of your system. Follow the procedure below carefully. Note that: 

• You must not adjust the Channel volume sliders away from the maximum at any point in this procedure. 

• It is not necessary to get all test meter readings at exactly the target level. The aim of the procedure is 

simply to reduce gain differences between channels, not to eliminate them. 

• In step 6, there is a judgment call on which channels should have increased gain and which should have 

reduced gain. 

• It is possible that you will get to step 7 and realize that there is nothing you can do to improve the gain 

structure of your system. 

 

Changing the connection type or gain structure settings of individual channels will invalidate all of 

your existing Dirac Live projects. You will need to discard all existing projects and filter sets after 

completing this procedure, and redo your Dirac Live calibration. 

 

7.3.1 Procedure for optimizing output gain 

1. If your amplifiers have gain controls, set them all to maximum (including the subwoofer). 

2. Quit and restart the DiracLive application. 

3. On the Volume Calibration tab, set the Output volume low and turn on the test signal for channel 1. 

Adjust Output volume and Input gain so the meter reads in the middle of the green area i.e. −12 dB. 

4. Turn on the test signal for the remaining channels and note the level of the test signal on the meter (for 

example, −6 dB, −15 dB, etc). 

5. Determine the target level for each channel: 

a. The speaker channels should all have the same target level. 

b. The subwoofer target is the same as the speakers. 

6. Using the tables on the next page, decide on the best method to change the gains of each channel to get 

closer to the target values. 

7. Power off the power amplifiers and the DDRC-88A, and make the changes. 

8. Power on the DDRC-88A and the power amplifiers, restart the DiracLive application, and re-run the 

levels check on the Volume Calibration tab. 
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7.3.2 To increase output gain 

 

7.3.3 To reduce output gain 

 

Before  After Gain change (approx.) 

DIP switch DOWN Dip switch UP +6 dB 

Unbalanced connection Balanced connection (*1) +12 dB (*2) 

Unbalanced connection Balanced to unbalanced adapter (*3) +6 dB 

*1. This change can be made only if your amplifier has balanced inputs. 

*2. This gain change applies in the typical case in which the amplifier has the same sensitivity/gain on both 

balanced and unbalanced input connections. Some amplifiers have half the sensitivity on the balanced 

inputs, in which case this connection change will result in a +6 dB gain change. Please check the 

specifications of your amplifier. 

*3. See page 45 for wiring. 

 

 

 

Before  After Gain change (approx.) 

Amplifier gain full Amplifier gain reduced −variable 

DIP switch UP Dip switch DOWN −6 dB 

Balanced connection Unbalanced connection (*4) −12 dB (*5) 

Balanced connection Balanced to unbalanced adapter (*4,*6) −6 dB (*7) 

*4. This change can be made only if your amplifier has unbalanced inputs. 

*5. This gain change applies in the typical case in which the amplifier has the same sensitivity/gain on both 

balanced and unbalanced input connections. Some amplifiers have half the sensitivity on the balanced inputs, 

in which case this connection change will result in −6 dB gain change. Please check the specifications of your 

amplifier. 

*6. See page 45 for wiring. 

*7. This gain change applies in the typical case in which the amplifier has the same sensitivity/gain on both 

balanced and unbalanced input connections. Some amplifiers have half the sensitivity on the balanced inputs, 

in which case this connection change will have no useful effect. Please check the specifications of your 

amplifier. 
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8 ENHANCED/BASS MANAGEMENT MODE 

In enhanced/bass management mode, the DDRC-88BM plugin has a powerful set of additional signal processing 

functions. This section acts as a reference for these functions. There are additional application notes on our 

website that give specific examples of plugin usage: 

• Implementing active speakers with the DDRC-88BM 

• Optimizing multiple subwoofers with the DDRC-88BM and Multi-Sub Optimizer 

• Bass management with the DDRC-88BM 

Note that acoustic measurement capability will be required to properly configure and use the DDRC-88BM 

plugin – see the Acoustic Measurement section of the application notes library on our website for details. 

8.1 PLUGIN USER INTERFACE – ENHANCED/BASS MANAGEMENT MODE 

Upon starting the plugin, the main user interface appears. The screenshot below shows the user interface with 

the key areas highlighted. 
 

Be sure to quit the DiracLive application before pressing the Connect button in the DDRC-88BM 

plugin. This avoids any possible communication conflicts. 
 

At the top of the screen are a set of menus and buttons, which are described on following pages. Below that is a 

set of tabs, which select the processing to configure. These tabs correspond to the sections of the signal flow 

diagram described on the next page. In the main part of the screen is the display for each of the tabs. 
 

http://www.minidsp.com/
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Once the DDRC-88A has been configured, the plugin is no longer required, as source and preset selection can be 

done with the front panel or a remote control (see pages 21 and 22). If desired, however, the user interface can 

remain online during use for real-time (“live”) adjustment of the settings. 

8.2 SIGNAL FLOW 

The signal flow diagram of the DDRC-88BM when in enhanced/bass management mode is shown in the diagram 

below. 

 
 

LFE Mgt 

 The eight input channels are each routed to a low pass filter and summed to provide the 

subwoofer signal. In addition, each channel is optionally high pass filtered. 

Routing (pre-Dirac) 

 The eight high pass filtered channels and the subwoofer signal are routed into a 9-into-8 matrix 

mixer. Each input signal to this block can be mixed at any level to each output. 

Dirac 

 The DRC block implements the Dirac Live room correction algorithm. Dirac Live is configured 

with the separate DiracLive application. This tab will show the level and delay that DiracLive has 

assigned to each channel. See page 18. 

Mixer (post-Dirac) 

 A second matrix mixer (8-into-8) routes the Dirac Live output signals to the output channels. This 

enables arbitrary mixing of room-corrected signals to output channels. 

Outputs 

 Each output channel has a full suite of miniDSP’s audio processing functionality, including 

parametric EQ, high/low (crossover) filters, gain and delay. 
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8.3 PLUGIN DESIGN/CONFIGURATION GUIDE 

The DDRC-88BM plugin is an extremely powerful and flexible tool. To understand how to utilize it effectively, it 

is important to understand how test/measurement signals are injected into the signal processing flow. 

The diagram below shows the signal flow diagram with a red arrow at the point where the Dirac Live test signal 

is injected. This occurs on the Measure tab of the DiracLive application. Thus, the signal received at the 

microphone will include the effects of the Mixer, the output channel processing, the speaker, and the room. 

Dirac Live will calibrate for the effect of all of these. 

Shown on the diagram in blue is where the test signal is injected if using an external measurement program 

(such as REW). In this case, the test signal passes through all of the processing blocks, including Dirac Live. 

Therefore: 

• If using an external test signal to set up the output channels in applications like active speakers, the Dirac 

Live filters on that preset must be unloaded (dragged onto the trashcan icon). 

• If using an external test signal to accurately set up bass management, this must be done after Dirac Live 

calibration, and on the same preset.  

 

In summary, the best general approach to configuring the DDRC-88A with the enhanced/bass management 

functionality is as follows: 

1. Use the plugin to configure the output channels. In designing an active speaker, this may mean locating the 

speaker to minimize the effect of reflections. 

2. With the speakers and subwoofer(s) positioned in their final location, perform a Dirac Live calibration. 

3. Use the plugin to configure bass management (if required). 

 

http://www.minidsp.com/


   

miniDSP Ltd, Hong Kong / www.minidsp.com / Features and specifications subject to change without prior notice 33 

8.4 CONNECTING AND CONFIGURATIONS  

The DDRC-88BM plugin can communicate with the processor using either USB or over the network. For USB 

communication, connect the DDRC-88A to a USB 2.0 port on your computer. Then click on the Connect button: 

 

For networked communication with the processor, a miniDSP WI-DG Wifi/Ethernet to USB bridge must be used 

together with the IP Address and Auto fields. See the Wi-DG User Manual for details. 

If connection is successful, the button changes to a green tick as shown above and the plugin is now online. 

When the plugin is online, any changes made in the DDRC-88BM plugin are immediately transferred to the 

processor and will be heard in the audio signal. 

8.4.1 Connection options 

The first time you connect, or if you have made any changes to any data in the user interface, the following 

dialog box will appear. It is recommended that the first time you connect, use Restore Config to ensure a known 

starting state. Thereafter, use Synchronize Config. 

Synchronize Config 

 Download the data for the currently selected configuration into the DDRC-88A. Note that this 

applies only to data that can be changes in the DDRC-88BM plugin — Dirac Live filters are not 

changed by doing this. After downloading the configuration data, the plugin is online. 

Synchronize and Upgrade 

 This is similar to Synchronize Config, but also upgrades the internal data of the DDRC-88A. This 

option may appear after downloading and installed an updated version of the plugin. 

Restore Config 

 Restore the data in the currently selected configuration to the factory defaults. Note that this 

applies only to data that can be adjusted in the DDRC-88BM plugin — Dirac Live filters are not 

changed by doing this. When using this option, connected amplification should be muted or 

turned off until you have set the configuration to a working state. Configuration data will be lost, 

so if needed, ensure that you have saved the configuration to a file prior to using this option. 

After restoring, the plugin is online. 

Help This option brings up a help screen explaining the options. 

Cancel This option cancels the attempt to connect to the DDRC-88A. The plugin will remain offline. 

http://www.minidsp.com/
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8.4.2 More about configurations 

The effect of changes made in the user interface fall into two categories: 

The plugin is online 

 The user interface is “live” – that is, any changes made to the audio processing parameters in 

the user interface are downloaded immediately to the DDRC-88A. The effect of these changes 

will thus be audible as the changes are made. 

The plugin is offline 

 Changes made to the audio processing parameters in the plugin user interface will be made 

locally only. The next time the plugin goes online, these parameters will be downloaded to the 

processor (as long as the Synchronize Config button is selected). 

 

The configuration contained in the miniDSP hardware unit cannot be uploaded back to the 

computer. Therefore, you must save your configuration to a file if you wish to recover from any 

changes you make while offline. 

 

8.4.3 Selecting a configuration 

The current configuration is selected by one of the four buttons in the Configuration Selection area. By default, 

configuration 1 is selected: 

 

To switch to a different configuration, click on a different button. There are two cases: 

The plugin is online 

 Audio processing will switch to the parameters of the selected configuration. If, however, 

parameters of the selected configuration have been changed since the last time that 

configuration was synchronized, then a dialog will appear asking you if you want to synchronize. 

The plugin is offline 

 The user interface will update to show the parameters of the newly selected configuration. If 

this configuration is changed in the user interface, it will be downloaded to the processor the 

next time it is synchronized. 

We recommend that all configurations be selected and checked/initialized prior to passing audio 

through the DDRC-88A, to ensure that audio processing parameters are in a known state. 

8.4.4 Saving and loading configurations 

Configurations can be saved to and loaded from files. Each configuration is stored in a separate file. It is strongly 

recommended that each configuration that you program into the DDRC-88BM be saved to a file, to ensure that 

the data is not lost if the DDRC-88A is inadvertently reset. A configuration file stores all of the DDRC-88BM audio 

processing parameters except for the master volume setting. 
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To save the currently selected configuration to a file, drop down the File menu, then select Save and then Save 

current configuration. In the file box, select a location and name of the file, and save it. 
 

To load a configuration, first select the configuration preset that you wish to load the parameters into. Then 

drop down the File menu, select Load, and then Load configuration to current slot. 

 

If the plugin is online, the new configuration data will be downloaded to the DDRC-88A immediately. If the 

plugin is offline, the data will be loaded into the user interface only, and will be downloaded to the DDRC-88A 

the next time it is synchronized. 
 

To copy a configuration from one preset to another, simply save the configuration to a file, then 

select a different preset and load the file. 

 

A stored configuration contains the data for the DDRC-88BM plugin only. It does not contain a Dirac 

Live filter set. To change the Dirac Live filters, use the Filter Export tab of the DiracLive application. 

8.4.5 Relationship with Dirac Live 

Each configuration preset in the DDRC-88BM plugin corresponds to the same-numbered filter set configured in 

the DiracLive application. For example, if the remote control or front panel is used to select preset 3, then both 

DDRC-88BM configuration 3 and Dirac Live filter set 3 are loaded for audio processing. 

The stored configuration file contains the data for the DDRC-88BM plugin only. The Dirac Live filters must be 

loaded separately using the DiracLive application. 

8.4.6 Restoring to defaults 

Configurations can be reset to the factory defaults from the Restore menu. There are two options: 

Factory Default 

 Reset all four configuration presets to the factory default settings. 

Current Configuration Only 

 Reset only the currently selected configuration preset to the factory default settings. 

If the plugin is online, the configuration data on the processor (all or just one configuration, as selected) will also 

be reset to factory defaults. Otherwise, the reset will take place in the user interface only, and the new 

configuration data will be downloaded to the processor next time it is synchronized. 
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8.5 SIGNAL PROCESSING TABS 

In enhanced/bass management mode, the row of five selection tabs is fully enabled: 

 

Each tab selects the information/control display for the key blocks shown in the signal flow diagram on the 

previous page. Each is described in detail in following sections, except for the Dirac tab which is described on 

page 18. 

Note that the tabs are usually set up from right to left – that is, the output channels are configured, then Dirac 

Live calibration is performed, then the bass management is set up. 

8.6 LFE MGT 

When movies are mixed for the cinema, each speaker is specified as a full bandwidth channel—that is, 20 Hz to 

20 kHz, although 40 Hz to 18 kHz for the speakers is considered acceptable in cinema and the mixing studio (see 

the Grammy paper “Recommendations For Surround Sound Production”). The Low Frequency Effects (LFE) 

channel is used for high-level low-frequency content and is fed to dedicated subwoofers in order to avoid 

overloading the speakers. 

In a typical home theatre system, some or all of the speakers are not capable of reproducing frequencies down 

to 40 Hz, let alone 20 Hz. The solution is bass management, where low frequencies are filtered out from the 

speaker channels and sent to the subwoofer instead. 

This is the LFE Mgt screen: 

http://www.minidsp.com/
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To generate the subwoofer (“LFE Mgt”) signal, the input channels are low pass filtered in the LPF blocks, and 

then summed together. The controls for each LPF block are similar to those seen in the Xover blocks in the 

output channels, but only have a single low pass filter and are limited to a maximum slope of 24 dB/octave. 

The gain control blocks (labelled with the attenuation, such as "0 dB" or "-10 dB") set the levels at which the low 

pass filtered signals from each channel are mixed together. To set the gain, right-click on the box and use the 

slider, or type directly into the entry box. Then click Close. To turn off low frequency mixing for a channel, simply 

click on the gain control box to set it to Off. 

The HPF blocks are used to create matching high pass filters for each channel. The high-pass filtered signals are 

passed through to the Routing tab. 
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8.7 ROUTING 

This tab mixes or routes the input channels and the LFE Mgt signal, and send them to the Dirac Live processing 

algorithm. The input channels are labeled along the left, and the output channels are labeled along the top. 

There are 9 input channels and 8 output channels. Here is the default setting: 

 

At each crosspoint of the matrix, the input channel (labels along the left) is mixed into the corresponding output 

channel (labels along the top) if the lettering is highlighted in yellow. The crosspoint is turned on and off by 

clicking on it. Any number of input channels can be mixed to each output channel. 

At each crosspoint, the gain of the signal being mixed can be adjusted to a value between -72 and +12 dB. To 

adjust the gain, right-click on the cross-point and a gain control will appear. Adjust the gain with the slider, or by 

typing in the value directly. This screenshot shows the gain control, with two input channels mixed to one 

output channel, each at -6 dB: 

Note: To rename an input channel, click on its label and type in a new name (maximum of eight characters). 

8.8 MIXER 

This tab mixes the eight signals from the Dirac Live processing and routes them to the individual output 

channels. The input channels are labeled along the left and the output channels are labeled along the top. 
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This is the default setting: 

 

In a typical straightforward home theater application, each channel from Dirac Live is routed directly to each 

output channel. In more sophisticated configurations, each output from Dirac Live might be routed to multiple 

output channels to implement active loudspeakers, or for multiple subwoofers. 

The gain of the signal being mixed can be adjusted at each crosspoint to a value between -72 and +12 dB. 

Note: To rename an output channel, use the Outputs tab. 
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8.9 OUTPUTS 

The Outputs tab provides full control over each output channel. Each channel has a “strip” of controls: 

 

8.9.1 Channel label 

The name of each output channel is shown at the top of the channel strip. To rename a channel, click on the 

channel label and type a new name (up to eight characters). 

8.9.2 Gain control and level monitoring 

The gain of each channel can be adjusted by moving the Gain Adjustment slider, or by typing the desired gain 

into the Current Gain text box. The maximum gain setting is 12 dB, and the minimum gain setting is –72 dB. (0 

dB, the default, is unity gain or no change in level.) 

The signal level on each output channel displays in two locations: on the bar-graph meter, and as a numeric 

value (in dB relative to full scale) in the RMS Level box. The RMS level displays only when the plugin is online. 

The level meters are useful in many situations. For example, when adding filters with boost, monitor the level 

meters with typical signals and maximum levels to ensure that there is no clipping. The meters can also be used 

during normal operation to monitor for or to help locate level or gain structure problems. 
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8.9.3 Parametric EQ 

Parametric equalization (PEQ) is a flexible type of equalization filter. It can be used to correct for errors in 

loudspeaker output, to compensate for acoustic room effects, and to tailor the overall system response for best 

sound. Click on the PEQ button to open the parametric equalizer settings window:  

 

In the center of the window is a frequency response graph that illustrates the combined response of all enabled 

parametric filters on that channel. The screenshot above shows a response curve created with a low-shelf boost 

filter at 100 Hz, a dip at 500 Hz, and a high-shelf cut filter at 5000 Hz. 

There are ten filters per channel, each of which is displayed by clicking on the buttons EQ1, EQ2, and so on. Each 

filter can be set to one of four types: 

PEAK Create a dip or a peak in the frequency response. 

LOW_SHELF Reduce or increase part of the frequency spectrum below a given frequency. 

HIGH_SHELF Reduce or increase part of the frequency spectrum above a given frequency. 

SUB_EQ Create a dip or a peak in the frequency response at low frequencies (10 to 50 Hz). This filter type 

is similar to PEAK but gives more accurate results for low frequencies. Note that activating any 

SUB_EQ filter reduces the number of available filters on that channel from ten to nine. 

Each filter has three parameters that control its location and shape. These parameters can be entered directly as 

numerical values, or by using the sliders: 

Frequency For the PEAK and SUB_EQ filter types, this is the center frequency of the peak or dip. For the 

HIGH_SHELF and LOW_SHELF filter types, this is the frequency at which the gain is half of the set 

value. 

Gain For the PEAK and SUB_EQ filter types, this is the gain in dB at the center frequency. For the 

HIGH_SHELF and LOW_SHELF filter types, this is the gain in dB reached at high or low 

frequencies respectively. 
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Q Q controls the “sharpness” of the filter. For the PEAK and SUB_EQ filter types, lower Q gives a 

shallower peak or dip, while higher Q gives a narrower peak or dip. For the HIGH_SHELF and 

LOW_SHELF filter types, Q controls how quickly the filter transitions from no gain to maximum 

gain. 

To disable or enable a filter, click on the Bypass button. A filter will also have no effect if its gain is set to 0.0. 

Other filter types can be created by switching to Advanced mode. In this mode, the coefficients of each filter 

“biquad“ are entered individually. The coefficients will need to be calculated by a filter design program. A useful 

spreadsheet for a number of filter types is available on the miniDSP.com website – see the application note 

Advanced Biquad Programming. 

 

Each channel can be linked to one other channel. When a channel is linked to another, the PEQ settings of that 

channel are mirrored to the other. Typically, the corresponding left and right channels are linked: front left and 

right, surround left and right, and rear surround left and right. To link a channel, select the other channel from 

the drop-down menu at the top left of the PEQ screen, and click the Link checkbox. 
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8.9.4 Crossover settings 

Each output channel has independent high pass and low pass filters. Click on the Xover button to open the 

crossover settings window: 

 

By default, the crossover filters are bypassed (disabled). Click on the Bypass button to enable and disable a 

crossover filter. There is one filter for high pass (low cut) and one for low pass (high cut). The above example 

shows a pair of filters for the subwoofer channel with an 18 Hz high pass filter and an 80 Hz low pass filter. 

Each filter can be set to one of a range of filter types and slopes. The filter type determines the shape of the 

filter around the crossover point, and the filter slope (expressed in dB/octave) determines how steep the filter 

cutoff is. The available filter types and slopes are: 

Butterworth (BW) 

 Available in 6, 12, 18, 24, 30, 36, 42, and 48 dB/octave, Butterworth crossover filters are 3 dB 

down at the cutoff frequency. 

Linkwitz-Riley (LR) 

 Available in 12, 24, and 48 dB/octave, Linkwitz-Riley crossover filters are 6 dB down at the cutoff 

frequency. 

Bessel 

 Available in 12 dB/octave only, a Bessel filter gives a more gradual roll off through the crossover 

region. 
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For other types of filter and filter slopes, use Advanced mode. This mode allows you to enter the coefficients of 

eight biquads directly into the interface. The coefficients will need to be calculated by a filter design program. A 

useful spreadsheet for a number of filter types is available on the miniDSP.com website – see the application 

note Advanced Biquad programming. 

 

Each channel can be linked to one other channel. When a channel is linked to another, the crossover settings of 

that channel are mirrored to the other. Typically, the corresponding left and right channels are linked: front left 

and right, surround left and right, and rear surround left and right. To link a channel, select the other channel 

from the drop-down menu at the top left of the Xover screen, and click the Link checkbox. 

8.9.5 Time delay 

A delay of up to 1000 ms (1 second) can be applied to each output channel. To set the delay, click in the delay 

entry box for a channel. The delay value can be entered numerically, and the up and down arrows can be used 

to change the delay in small (0.02 ms) increments. 

8.9.6 Invert and mute 

Each channel can be inverted in polarity, and individually muted. When either of these options is selected, the 

display changes color and the label of the button reflects the current state. 
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9 ADDITIONAL INFORMATION 

9.1 BALANCED WIRING TIPS 

9.1.1 Phoenix terminal blocks 

To make balanced connections, remove the terminal blocks from the rear of the DDRC-88A. Connect individual 

wires from a shielded pair cable to each set of screw terminals as shown below. After all connections to the 

terminal block are secure, firmly re-insert the terminal blocks. 

9.1.2 XLR adapters 

If connecting the DDRC-88A to equipment that uses XLR connectors, suitable cabling can be made by cutting 

XLR-XLR or microphone cables in two. The two halves are then used for input and output, as shown here: 

9.1.3 RCA adapters 

In certain special cases, it can be helpful to connect a balanced input or output of the DDRC-88A to an 

unbalanced (RCA) connection on the source or power amplifier. The connection scheme is shown below. Note 

that the cable shield must be connected to the ‘−’ terminal on the DDRC-88A input, whereas on the output side, 

the ‘−’ terminal is not connected. 
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9.2 SPECIFICATIONS 

Computer connectivity Driverless USB 2.0 control interface for Windows and macOS 

Analog inputs 8 x Balanced (Terminal Block) or 8 x Unbalanced (RCA) inputs 

• Maximum balanced input voltage: 8 VRMS 

• Maximum unbalanced input voltage: 2.0 or 0.9 VRMS (jumper selectable) 

Analog outputs 8 x Balanced (Terminal Block) and 8 Unbalanced (RCA) outputs 

• Maximum balanced output voltage: 8.0 or 4.0 VRMS (DIP switch selectable) 

• Maximum unbalanced output voltage: 2.0 or 0.9 VRMS (DIP switch selectable) 

Input impedance Unbalanced: 10 kΩ 

Balanced: 47 kΩ 

Output impedance Unbalanced: 560 Ω 

Balanced: 1.12 kΩ (560 Ω each signal pin) 

Audio sample rate / 

Resolution 

Input/output resolution: 24-bit integer 

Sample rate: 48 kHz 

Audio processing 32-bit floating-point processor 

Storage/Presets 4 filter sets stored, selectable from front panel or IR remote 

Infrared remote “Learning remote” capabilities (NEC, Philips, Sony, Apple) 

Controls master volume, mute, filter set selection, Dirac Live® filtering enable 

Power supply 12 VDC single supply 

Dimensions (H x W x D) 41.5 x 429 x 252 mm; 1RU height 
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9.3 MCU FIRMWARE UPDATE 

miniDSP may occasionally provide an update to the DDRC-88A MCU firmware to enable new features. To update 

the MCU firmware, first download and install the latest version of the DDRC-88BM plugin from the User 

Downloads section of the miniDSP website. Then follow the instructions below for your platform. 

There may be older DDRC-88A units in the field (shipped prior to August 2016) that require a firmware 

update of the main board firmware in addition to the MCU. If you have a unit shipped prior to August 

2016 that has not had a main board firmware update, contact miniDSP Support. 
 

DO NOT DISCONNECT THE USB CABLE OR POWER FROM THE DDRC-88A WHILE FIRMWARE UPDATE IS 

IN PROGRESS. DOING SO MAY “BRICK” YOUR DDRC-88A. 
 

9.3.1 Windows 

1. Download and install the latest version of the DDRC-88BM plugin. 

2. Connect the DDRC-88A to your computer via USB and power it on. 

3. Start the DDRC-88BM plugin. 

4. If you have previously used the DDRC-88BM plugin and have configurations that need to be saved, save 

them to files now. 

5. Click on the Connect button. 

a. If your unit does not require requires a firmware upgrade, the connect button will change to a green 

tick and you do not have to proceed any further. 

b. If your unit does require a firmware upgrade, a warning dialog will pop up. Click OK: 

 

6. The DDRC-88A will automatically be put into boot loader mode and the miniDSP upgrade utility will start. 

The status area should display “Device attached”. 
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7. Click on the Open Hex File button and select the .hex file in the firmware folder of the download. It will 

have a name like ENC_DDRC88BM_Ver2.26_SS.hex. 

 

Check the file name carefully! Do not upload a file named miniDSP_2x8_8x8_v2.10_release.hex! 

 

8. Click on the Program/Verify button. The status bar will indicate progress. Do not disconnect the USB cable 

or remove power from the processor while this runs!  

9. After the status indicates that the verify has completed successfully, click on the Reset Device button, and 

then quit the upgrade utility. 

10. Return to the DDRC-88BM plugin. (If there is a dialog informing "Connection to DSP closed," click on OK.) 

Click on the Connect button. 

11. You may see the following dialog. This can occur if you upgraded from an earlier DDRC-88A unit without 

bass management. (If this does not appear, skip the next step.) 

 

12. If the dialog appears, click on Restore ALL to Default. (If you click on Upgrade & Synchronize, the plugin 

will detect a mismatch and you will need to click Restore factory settings in the dialog shown below.) 

 

13. When the plugin connects, the Connect button will change to a green tick. 

 

14. Drop down the Help menu and select About... to verify the new firmware version. 
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9.3.2 macOS 

1. Download and install the latest version of the DDRC-88BM plugin. 

2. Connect the DDRC-88A to your computer via USB and power it on. 

3. Start the DDRC-88BM plugin. 

4. If you have previously used the DDRC-88BM plugin and have configurations that need to be saved, save 

them to files now. 

5. Click on the Connect button. 

a. If your unit does not require requires a firmware upgrade, the connect button will change to a green 

tick and you do not have to proceed any further. 

c. If your unit does require a firmware upgrade, a warning dialog will pop up. Click OK: 

 

6. The DDRC-88A will be put into boot loader mode and the miniDSP bootloader program will start. The status 

area should display “Device attached” and then “Device Ready.” 
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7. Click on the Import Firmware Image button and select the .hex file located in the firmware folder of the 

download. It will have a name like ENC_DDRC88BM_Ver2.26_SS.hex. 

 

Check the file name carefully! Do not upload a file named miniDSP_2x8_8x8_v2.10_release.hex! 

 

8. Click on the Erase/Program/Verify Device button. The status display will indicate progress. Do not 

disconnect the USB cable or remove power from the processor while this runs!  

9. After the status indicates that the verify has completed successfully, click on the Reset Device button, and 

then quit the bootloader program. 

10. Return to the DDRC-88BM plugin. (If there is a dialog informing "Connection to DSP closed," click on OK.) 

Click on the Connect button. 

11. You may see the following dialog. This can occur if you upgraded from an earlier DDRC-88A unit without 

bass management. (If this does not appear, skip the next step.) 

 

12. If the dialog appears, click on Restore ALL to Default. (If you click on Upgrade & Synchronize, the plugin 

will detect a mismatch and you will need to click Restore factory settings in the dialog shown below.) 

 

13. When the plugin connects, the Connect button will change to a green tick. 

 

14. Drop down the Help menu and select About... to verify the new firmware version. 
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9.4 ACTIVATING ENHANCED/BASS MANAGEMENT MODE 

The following procedure converts a DDRC-88A from basic mode to enhanced/bass management mode. It only 

needs to be applied to a DDRC-88A that was purchased in basic mode, after later purchasing the plugin upgrade 

from the miniDSP website: 

• https://www.minidsp.com/products/dirac-series/ddrc-88bm 

 

The DDRC-88A must be running the current firmware before doing this step. See Section 9.3 MCU 

Firmware update. 

 

1. Download and install the latest version of the DDRC-88BM plugin from the miniDSP.com website. 

2. Start the plugin and click the Connect button. 

3. Drop down the Help menu and select “Activate Bass Management”. 

4. The following screen will appear: 

 

5. Click on the button “Copy Activation Code to Clipboard.” 

6. Send an email message to info@minidsp.com with the Subject line “DDRC-88-BM Activation Request.” In 

the body of the email message, paste the activation code. miniDSP will respond in normal (Hong Kong) 

working hours with an activation key file (.txt file). (Please note that this is not an automated process.) The 

activation key file contains a key text string consisting of 128 pairs of letters separated by spaces (total 256 

letters). 

7. Click the “Import” button and select the received activation key file to import into the plugin. If successful, 

you will then see the normal connection dialog box (as on page 33). 
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9.5 TROUBLESHOOTING 

The following table lists the most common causes of issues with the DDRC-88A. If following this table does not 

provide a solution, see Obtaining Support. 

 

1 Cannot install 

software 

a. Confirm that you downloaded and installed the required frameworks 

first (see Software Installation). 

2 Plugin running in 

background but not 

showing  

a. The plugin may need a network connection the first time you run it. 

Close the plugin program, ensure that your computer has a network 

connection, and restart the plugin. 

3 Plugin cannot 

connect 

a. Check that the USB cable to the DDRC-88A is firmly connected  

b. Reset the processor by power-cycling the unit. 

4 No signal showing 

on Dirac Live input 

meters 

a. Check the cabling from your source. 

b. Check that your source is playing audio and that it is not muted or have 

volume control turned down. 

c. Check that the plugin is synchronized with the hardware unit. 

5 Low audio on 

outputs 

a. Check the cabling from the processor to your amplifiers. 

b. Check that your amplifiers are turned on and that any volume controls 

are turned up. 

c. Check that the input and output meters are showing signal. 

d. Check that master mute is not enabled. 

e. Check the master volume level. 

f. Check that your crossover frequencies are correct e.g. that you don’t 

have high pass and low pass frequencies incorrectly set. 

g. Check that the matrix mixer is sending the correct inputs to the correct 

outputs. 

6 Audio sounds 

distorted 

a. Check the output meter and ensure that you are not overloading the 

outputs. If necessary, reduce the output gain and/or the amount of 

boost in the EQ blocks. 

7 Audio is coming 

through the wrong 

outputs 

a. Check the cabling from the processor to your amplifiers. 

b. Check that you have correctly set up the matrix mixer to send the 

correct inputs to the correct outputs. 

8 Cannot reload a 

configuration 

a. Confirm the file format of your file (.xml). 

b. Confirm the version of the file. 
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9.6 OBTAINING SUPPORT 

1. Check the forums on miniDSP.com to see if this issue has already been raised and a solution or solutions 

provided. 

2. Contact miniDSP via the support portal at support.minidsp.com with: 

a. The product information obtained from DDRC-88BM plugin (Help -> About...) and the DiracLive 

application. 

b. A clear explanation of the symptoms you are seeing. 

c. A description of the troubleshooting steps you performed and the results obtained. 
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